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1 Introduction
Newvic CNC System is self-developed by Nanjing Viccam Technology Enterprise Co., Ltd. And its copyright is also belong to this company. 

Newvic CNC System supports G codes, generated by CAD/CAM software such as type3, UG, MasterCAM, CASMATE, ArtCAM and so on.
Besides manual, step-by-step, automatic and return-to-mechanical-origin functions, the CNC system reserve special functions for complicated mold machining, advertising decoration and cutting-simulation, dynamic display tracking, Z axis automatic calibration, break-point memory (program skip execution) and rotation axis machining.
The software is based on MicroSoft Windows operating system, gives full play to 32 bit computation and multitask advantages. At the same time, the windows style user interface is simple, reliable and easy to learn.
Newvic CNC System can be used together with Viccam CNC machine, and it is applicable to a variety of complex mold processing, advertising and decoration, cutting and other industries.
It includes the following features:
1) The basic configuration of the system has four movement axes. The user can further expand the switch input, switch output and analog output.
2) The automatic processing supports the complete ISO standard G commands, and supports the mainstream CAD/CAM software of the at home and abroad such as UG, Pro/E, MasterCAM, Cimatron, CASMate, ArtCAM, etc.
3) Manual function. Support the continuous jog and the increment step-by-step manual control modes.
4) Increment step-by-step function. It is convenient for the user to precisely set the feed, and its step length can be adjusted flexibly. 
5) Advanced start, the program skip execution function.
6) Breakpoint resume, advanced automatic processing function.
7) Simulation function. The system can perform fast simulation machining, and at the same time accurately calculate the actual machining time. The user can do intuitive judgment that the processing result whether meets the demand by this operation.
8) Manual and Auto tool changing function.
9) Motion axes accurately return to the mechanical origin (reference point) function.
10) Feed rate adjustment function. The user can adjust the feed rate in the stop or pause status.
11) Processing trace three-dimensional simulation display function. The user can watch the three-dimensional processing result from any angle and multi views by zooming, rotating, translating and so on operations, then he can understand the processing result intuitively and accurately.
12) System log function. The system can record the various operations of the user and do the related instructions real-time. It is convenient for the user to view the history operations and do system trace and diagnosis.
13) Program edit function. The user can edit and modify the processing commands and immediately execute them.
14) I/O state function. It is convenient for the user to examine the state of the machine real-time.
15) Parameters setting function. The user can modify the parameters according the actual processing need, and the system can automatically make backups.
16) Soft limit, fault alarm function. This function can improve the safety of the machine running.
17) Processing information illustrate. The file information window will be automatically popped up after the simulation or the actual machining finishing. It can help the user to statistic the file execution time, the processing range and so on.
18) Keyboard support. It will meet the needs of the user in the operation process.
19) Using the PCI bus motion control card.

2 Setup and Connection
2.1 System Requirements
Computer
CPU:      Dual-Core 2.5G or higher
Memory:
1G or above
Hard Disk:
20G or above
Display:    Minimum 800×600
Monitor:   12'' VGA or above

Operating system


Microsoft Windows XP Home
2.2 Installing Newvic
Newvic CNC System includes the motion control card and the control software two parts, so installing the System also includes two steps: installing the motion control card and installing the software.
2.2.1 Installing Newvic
Follow the steps below:
1) Turn power on. The computer starts and Windows run automatically. If Windows is not installed, install the operating system. V1.0 only temporarily supports WinXP.
2) After Windows starts, close any running application.
3) Place the Newvic CD into the CD-ROM drive.
4) Double-click the My Computer icon, and double-click the CD-ROM disk. Double-click setup.exe. The installation dialog box appears as shown below.
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Fig. 2.1 Installation Wizard
5) Click Next, select the installation folder.
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Fig. 2.2 Select Installation Folder
6) Click Next, confirm installation.
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Fig. 2.3 Confirm Installation
7) Installation complete, shut down the dialog box as shown below.
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Fig. 2.4 Installation Complete
8) Restart the computer. Afterwards, install the motion control card.
2.2.2 Installing the Motion Control Card
Turn off the computer, open the cover, and insert the motion control card into a compatible extension slot. Turn on the computer, popup the dialog box as shown below.
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Fig. 2.5 Hardware Wizard
Click Next, the system begin to install the driver software. The software is installed in the system disk (Default Disk C).
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Fig. 2.6 Hardware Wizard
Click Next, the system prompts the software has finished installing.
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Fig. 2.7 Hardware Wizard
Click Finish.
The whole system has finished installing.
3 The Newvic Window
First, run the program by double-clicking the shortcut link on the desktop. The Newvic Window as shown in Fig. 3.1, is mainly composed by title bar, menu bar, toolbar, status bar and some features windows. 
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Fig. 3.1 Operation Window
The function windows are divided into three areas:

Area 1: NC state window;

Area 2: Trace, Log, I/O State, Parameters, and Editor windows;

Area 3: Auto/Manual operation windows.
3.1 Title Bar
The Title Bar is on top of the Newvic window, which shows the names of the program and file. The color of the Title Bar indicates whether the window is active or inactive.
The icon at the left end of the title Bar is the system menu box, which opens the window control menu by clicking the icon or by using ALT+SPACE.
The system menu appears as shown in Fig. 3.2. This menu is used to control the window size and position.
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Fig. 3.2 System Menu
3.2 Menu Bar
Below the Title Bar is the Menu Bar. It contains pull-down menus, as shown in Fig. 3.3.
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Fig. 3.3 Menu Bar
Each pull-down menu consists of options. If some options in a pull-down submenu are grey, they cannot be chosen under the current condition. Each option corresponds to an assigned function, action or status. By choosing an option, its corresponding function or action will be performed, or status settings changed. Some options end with three dots (as in Open and Load…). This means that a dialog box will appear when an option is chosen. The options can be chosen by clicking or keyboard.

Mouse: Click a menu on the Menu Bar. When a pull-down menu shows, click a specific option.
Keyboard: Press down ALT and a menu hotkey (underlined letter, such as F in File, where ALT and F are used together for choosing the option). After choosing a menu, a  pull-down submenu appears.
Shortcut keys: In a pull-down submenu, on the right of some menu options are their shortcut keys. For example, the shortcut key for Start… in the Operation menu is F9. Pressing this key runs the menu command, which saves the trouble of entering layers of the menu.
3.2.1 File Menu
By clicking the main menu File of the menu bar, or pressing down ALT and the menu hotkey F, the File Menu will be opened. It contains the following options, as shown in Fig. 3.4.
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Fig. 3.4 File Menu
· Open and Load
The option opens an existing file and loads it into the NC file buffer zone. Its shortcut keys are CTRL+O. When the File Menu is chosen, the option also can be opened by pressing down the hotkey letter O. The three dots after the option means that a dialog box will appear when this option is chosen, as shown in Fig. 3.5.
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Fig. 3.5 Open and Load
To click the pull-down submenu of the Look in and transfer the required processing file path, then clicking the file, click Open, the target file can be opened. At the same time the trace and name of the current file are shown in the Title Bar of the main window.
· Unload

Unload the current processing file.
· Exit
This option is used to close the system.
3.2.2 View Menu
This menu is to achieve the control of the trace window during the processing or the simulating, hide and show the toolbar, display the processing information, as shown in Fig. 3.6. The function of this menu is as same as the pop-up menu by right-clicking the trace window.
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Fig. 3.6 View Menu
· Toolbar
This option is to achieve the display and hide of the toolbar. The “hook” mark in the front indicates the toolbar is displayed. This function can be performed by clicking or keyboard.
· Zoom
The cursor will be changed to the shape [image: image14.png]


 after clicking this menu. Click again, the cursor will be returned to the original standard arrow shape. Press down the left mouse button in the trace window, drag the mouse up can perform to zoom out and drag the mouse down can perform to zoom in. This function can also be performed by sliding the mouse pulley, and sliding up can perform to zoom in, sliding down can perform to zoom out.
· Rotate
The cursor will be changed to the shape [image: image15.png]


 after clicking this menu. Click again, the cursor will be returned to the original standard arrow shape. Press down the left mouse button in the trace window, drag the mouse to different directions or slide the mouse pulley can perform to rotate function. This function can realize the user watches the processing result from any angle. 
· Translate
The cursor will be changed to the shape [image: image16.png]


 after clicking this menu. Click again, the cursor will be returned to the original standard arrow shape. Press down the left mouse button in the trace window, drag the mouse to different directions can perform to translate function. The user can move the processing result to the display area in order to watch and detect the processing result better.

· Adjust to Window Size
Choose this option to adjust the current processing result to the window size. It is shown as the top view and the user can observe the all processing information.
· Initial Status
Choose this option, the current processing result view will be restored to the initial finished status.
· Change Display Status
Choose this option, the Display Option dialog box will be popped up, as shown in Fig. 3.7. The bright effect of the trace image will be shown by choosing the center of gravity or centre of the trace as the reference point to translate the trace along the different axes. For example, choosing the center of gravity as the reference point and translating the trace along the X axis direction, it means the points color of the trace in the X axis direction are shown more deep which close to the center of gravity and more bright which away from the center of gravity. The characteristic of the trace image in all direction can be shown by changing the display status.
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Fig. 3.7 Display Option Dialog Box
· Rotating Option
Choose this option, the Rotating Option dialog box will be popped up, as shown in Fig. 3.8.
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Fig. 3.8 Rotating Option Dialog Box
The user can choose freely the rotating angle, direction and check the classic views by the Rotating Option dialog box. The classic views include the front view, the back view, the left view, the right view and the vertical view.
· Idle Status Color Setting
This option is to set the trace line color of the idle status G00. Choose this menu, a color setting table will be popped up, as shown in Fig. 3.9. The user can select a specific color according to his need.
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Fig. 3.9 Color Dialog Box
· Background Color Setting
Choose this option, a color setting table will be popped up, as shown in Fig. 3.9. The user can select his favorite color as the background color of the trace window.
· Clear
When processing multiple files, actually the current processing result was hoped to be displayed. Click this menu, the system will clear the processing paths of the front.
· Side View
To choose this option, the processing trace window will display the side view of the trace image.
· Top View 
To choose this option, the processing trace window will display the top view of the trace image.

· Bottom View
To choose this option, the processing trace window will display the bottom view of the trace image.

· Front View
To choose this option, the processing trace window will display the front view of the trace image.
· Back View
To choose this option, the processing trace window will display the back view of the trace image.
· Left View
To choose this option, the processing trace window will display the left view of the trace image.
· Right View
To choose this option, the processing trace window will display the front view of the trace image.
· File Information
Click the option when simulation or in automatic machining, a dialog box will pop up, as shown in Fig. 3.10. This dialog box displays the statistical information of the processing program, such as the processing time, the operating range and the D-value, and the processing file path. The operating range are the max and the min coordinate values of the workpiece when the machine is moving in the process.
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Fig. 3.10 File Information of Processing Normally Finished
When the processing abnormally finished in the simulation or the machining because of such as the soft limit, the File Information window is shown as Fig. 3.11. Click Detail, a display box will be popped up and it marks the position and the reason for the soft limit.
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Fig. 3.11 File Information when Occurred Soft Limit
3.2.3 Operation Menu 

The Operation menu contains those options, such as shown in Fig. 3.12.
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Fig. 3.12 Operation Menu
· Set Workpiece Origin
Choose Set Workpiece Origin, and the workpiece coordinate of the current point is set to zero, which does not lead to actual position move. Clicking on the workpiece coordinate directly can also perform this function.
· Move to Workpiece Origin
Choose the Move to Workpiece Origin option, if the tool nose is below the safe height, Z axis will rise up to the safe height firstly. The X and Y are together gone back to the workpiece origin. Then Z is dropped to the safe height.
· Save Workpiece Origin
Choose this menu, click a group data to save the current workpiece origin to the CNC system, as shown in Fig. 3.13. There are eight groups coordinate data. The seventh data are the current setting workpiece origin, they will change with the setting change. And the other groups data will remain unchanged.
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Fig. 3.13 Save Workpiece Origin
· Load Workpiece Origin
This function of this option is to load the workpiece origin coordinate values which had been saved. It is corresponding with Save Workpiece Origin. Pay attention to the change of the seventh group data. It is illustrated that the workpiece origin of the current setting is the seventh group data, as shown in Fig. 3.14.
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Fig. 3.14 Load Workpiece Origin
· Return to Mechanical Origin
Choose this option, a dialog box will be popped up, as shown in Fig. 3.15. Select the axis button, the corresponding axis will return to the mechanical origin. Select All Axes button, all axes return to the mechanical origin in turn(Z axis first, then X and Y). 
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Fig. 3.15 Return to Mechanical Origin
The icon which indicates the axis has successfully returned to mechanical origin will be shown in front of each axis in the CNC status window, as shown in Fig. 3.16.
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Fig. 3.16 Icon of Successfully Return to Mechanical Origin
· Start
Click on this option after loading the processing file, the system will automatically enter the machining mode. At the same time, the user can real-time observe in the trace window, and the system log will record accordingly.
· Pause

Choose Pause option in automatic machining, the machine pauses and lifts the tool, then enters the pause status. To resume, choose the Start option.
· Simulate
Click on this option after loading the processing file, the system will automatically enter the rapid simulation machining mode. At the same time, the system will calculate the actual processing time and it is shown in the status bar. The user can real-time observe in the trace window, and the system log will record accordingly.

· Stop
Choose Stop option in automatic processing or during the simulation process, the system terminates the entire machining task, and enters the stop status.
· Advanced Start
This function is only executed in the stop status and this option performs program skip executions. Choose Advanced Start option in the stop status, the Start(advance option) dialog box will be popped up. The user chooses Beginning or fill in the line number to the Specific Line input box. The system will perform machining from the according line number. And the range of the Specific Line are the beginning and end line number of the professing file, as shown in Fig. 3.17.
[image: image27.png]Start (advanced option)

From:
Ogeainning
(@ Specific Line(From Line 0 to Line 23868)

=





Fig. 3.17 Advanced Option Dialog Box
· Breakpoint Resume
Choose this option, the system will automatically continue to perform machining from the line number of the last processing stopped. The user can select this function in the emergency stopping station. The machine moves to the breakpoint quickly to continue machining. And this operation can save the processing time.
· Fine Adjustment
This option is valid only in the Pause status in automatic machining. When used in non-interrupted machining, the option jiggles the depth. Click this menu in the Pause status, the Fine Adjustment dialog box will be popped up, as shown in Fig. 3.18. This function can not terminate the machining process, just make minor adjustments and the operation result only effect this processing task. Choose Start or Breakpoint Resume after the operation of Stop, the result of fine adjustment will be invalid.
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Fig. 3.18 Fine Adjustment Dialog Box
· Mobile Calibrator
With calibration, the user determines the coordinate in the Z direction of the workpiece origin and the adjusted coordinate in the Z direction after tool change. Place the calibration block, and choose Mobile Calibrator. After the dialog box appears, choose Yes for automatic calibration. The dialog box is as shown in Fig.3.19.
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Fig. 3.19 Mobile Calibrator Dialog Box
· Reset
Choose the Reset option, the machine is recovered to the Stop status. When the system is in the Disabled status because of Warning, Limit and so on in the machining process, click this menu, the ordinary functions of the machine will be recovered.

3.2.4 Help Menu
The Operation menu contains those options, such as shown in Fig. 3.20.
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Fig. 3.20 Help Menu

· Hot Key List

Click this option, the Hot &Key List dialog box will be popped up, as shown in Fig. 3.21. The user can check the all hot keys of the system by this dialog box.
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Fig. 3.21 Hot &Key List Dialog Box

· About New Viccam CNC System

Click this menu, a dialog box will be popped up which displays the version number of the system, the registration information and so on, as shown in Fig. 3.22.
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Fig. 3.22 System Information
3.3 Toolbar
Below the menu is the Toolbar. It consists of some buttons, corresponding to certain menu commands or options. Clicking the buttons will perform the specific functions, as shown in Fig. 3.23. The button is displayed gray which means this option can not be performed in the current station.
The Toolbar buttons simplify operations visually, and imply no more tedious command lines.
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Fig. 3.23 Toolbar
1 The button [image: image34.png]


 is corresponding with the Start of the Operation menu. Click this button after loading the processing file, the system will enter the automatic machining mode.
2 The button [image: image35.png]


 is corresponding with the Stop of the Operation menu. Click this button, the system terminates the entire machining task, and enters the stop status.
3 The button [image: image36.png]


 is corresponding with the Pause of the Operation menu. Click this button in the automatic machining process, the machine pauses and lifts the tool, and the system enters the pause status.
4 The button [image: image37.png]


 is corresponding with the Reset of the Operation menu. Click this button, the system recovers the stop status.
5 The button [image: image38.png]


 is corresponding with the Breakpoint Resume of the Operation menu. Click this button, the machine moves to the breakpoint quickly to continue machining.

6 The button [image: image39.png]


 is corresponding with the Simulate of the Operation menu. Click this button, the system will automatically enter the rapid simulation machining mode. At the same time, the system will calculate the actual processing time.
7 The button [image: image40.png]


 is corresponding with the Return to Mechanical Origin of the Operation menu. Click this button, the system will pop up the Return to Mechanical Origin dialog box.
8 The button [image: image41.png]


 is corresponding with the Move to Workpiece Origin of the Operation menu. Click this button, each axis accordingly returns to the workpiece origin depending on the current position of the cutter.
9 The button [image: image42.png]


 is corresponding with the Translate of the View menu. Click this button, the cursor will be changed to the shape of the button. Press down the left mouse button in the trace window, drag the mouse to different directions can perform to translate function.
10 The button [image: image43.png]


 is corresponding with the Rotate of the View menu. Click this button, the cursor will be changed to the shape of the button. Press down the left mouse button in the trace window, drag the mouse to different directions or slide the mouse pulley can perform to rotate function.
11 The button [image: image44.png]


 is corresponding with the Zoom of the View menu. Click this button, the cursor will be changed to the shape of the button. Press down the left mouse button in the trace window, drag the mouse up can perform to zoom out and drag the mouse down can perform to zoom in. This function can also be performed by sliding the mouse pulley, and sliding up can perform to zoom in, sliding down can perform to zoom out.
3.4 Status Bar
On the bottom of the screen is the Status Bar and it displays the CNC information, as shown in Fig. 3.24. The status bar is divided into three areas: displays the current CNC status, the processing time and some alarm information.
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Fig. 3.24 Status Bar
3.5 NC State Window
Below the Toolbar is the NC State Window, as shown in Fig. 3.25.This window can be divided into five areas depending on the different functions: the current position, federate, machine control, spindle federate and M01 switch.
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Fig. 3.25 NC State Window
· Current Position
Newvic shows two coordinate sets at once: the mechanical and workpiece coordinate sets. The user can view the two sets simultaneously and cut over freely, and set their relative offset. Clicking each of the coordinate display areas will reset the current position of the three axes to 0. The icons which mean the axes have returned to mechanical origin successfully will appear in front of each axis after the returned to mechanical origin, as shown in Fig. 3.16.
· Feedrate
The Feedrate area shows the feedrate setting, actual feedrate, feedrate percentage and Current Line (Block) No. The feedrate percentage can be pulled adjustment in the stop status. The feedrate setting a can be modified by setting the User Operate Parameters in the Parameters Setting window, as shown in Fig. 3.26.
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Fig. 3.26 Feedrate Setting Page
The initial default display of the feedrate setting is the normal jog feedrate for XY. The feedrate will change with the manual button during manual operation. When switching to High feedrate, it will display the rapid feedrate for XY. And moving each axis in positive and negative direction, it will display the rapid (or normal) jog feedrate of the corresponding axis.
The actual feedrate displays the instantaneous vale of the actual machining feedrate, and it changes with the feedrate setting, the current accelerated speed state and the feedrate percentage.
· Machine Control
This bar can control spindle and coolant start or stop. The buttons allow direct operation and reflect the machine status. Spindle and coolant actions can also be performed in machining.
· Spindle Feedrate
This bar can set the rotation speed of the spindle.
· M01 Switch
This option can automatically implement the pause function. Pressing the switch, the system will pause in the line of the M01code position in the processing file. 
3.6 Auto Window

The auto window shows the loaded file. The user can view the processing program by it. Right-click in the window and the context menu displays, as shown in Fig. 3.27.
Click Show File Line Number, the hook mark disappears that means the file line number is not shown in the current station. Click Trace Current Line Number, the hook mark appears that means the system can automatically track the current line number in the actual machining and the simulation process. And the menu Open and Load… and Unload are available in the File menu.
The Auto widow and Manual widow can switch each other. Clicking the window title can switch to this window.
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Fig. 3.27 Auto Window
3.7 Manual Window
The Manual window provides an interactive environment to operate the machine manually, as shown in Fig. 3.28. Clicking the Manual window title can switch to this window.
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Fig. 3.28 Manual Window
· MPG Selection
Click the MPG Disabled button, a prompt dialog box will be popped up, as shown in Fig. 3.29. Choose OK, the MPG mode will be enabled. 
Shaking the MPG, the machine will move until stopping to shake it. At this time Manual and other related operation buttons were gray, and the MPG Disabled button changes to the MPG Enabled button, as shown in Fig. 3.30.
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Fig. 3.29 Prompt Dialog Box
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Fig. 3.30 MPG Enabled
· Direction Button
The X+ and X- manual buttons are corresponding to the positive and negative direction of the X axis, and are also corresponding to the keypad number of 6 and 4 in the keyboard.
The Y+ and Y- manual buttons are corresponding to the positive and negative direction of the Y axis, and are also corresponding to the keypad number of 8 and 2 in the keyboard.
The Z+ and Z- manual buttons are corresponding to the positive and negative direction of the Z axis, and are also corresponding to the keypad number of 9 and 1 in the keyboard.
· High/Low Speed Selection
The middle button is High/Low button. Click this button in the Low status, and it changes to High immediately, and the system will operate the manual with the high speed which has set. And Click it in the High status, the system will do corresponding reaction.
· Feeding Mode Selection
The Manual window provides an interactive environment to operate the machine manually.
The continuous point motion and increment step-by-step modes for manual operation are described below:

Continuous jog mode: When the Manual window is active, press down the corresponding keys on the keypad. When the keys are pressed down, the machine starts action. While they are released, the machine stops action. 
While performing jog motion, the Trace window shows the trace with the color of G00 commands.

Increment step-by-step mode:
Briefly the increment mode or the step-by-step mode, this is another mode for manual operation. The user performs increment feed operations in an interactive window using the mouse or keyboard, or by manual operation of the manual panel or box. The triggering of a manual button corresponds to the given step length of axis motion.
Before the mode is used, the appropriate step length must be set. The feed distance of the increment motion can be set by modifying its step length.

By keyboard: When the increment motion window is active, increase or reduces the increment motion step length using arrow keys. Changes in the step length button will be observed.

By mouse: Click the appropriate step length button with the mouse.
After appropriate step length be set you can operate machine with button on keyboard or mouse.
Note: The defined step value is not set too large, so as to avoid damaging the machine because of the misoperation.
3.8 Trace Window
In running the file, simulation or manual operation, the Trace window traces tool machining real-time, as shown in Fig. 3.31. The three-dimensional real-time trace display allows the user to detect the tool path visually, to ensure that the file make no errors.
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Fig. 3.31 Trace Window
Right-click in this window, a shortcut menu will be popped up, as shown in Fig. 3.32. The function and operation of this menu options are corresponding to the options of the View menu.
The executive function of the menu option Zoom, Rotate and Translate are also corresponding to the three buttons of [image: image53.png]


, [image: image54.png]
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 in the Toolbar. The user can easily adjust the appropriate scaling, the different angles and the different sizes to view the processing result by these menu options to realize the processing result better.
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Fig. 3.32 Shortcut Menu of Trace Window
3.9 Log Window
The Log window records the state and the time of the current operations and events. Click the event, a dialog box will be popped up which displays the additional information of the event, and click again, it will be taken back, as shown in Fig. 3.33.
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Fig. 3.33 Log Window
3.10 I/O State Window
The I/O State (input/output state) Window real-time displays the current I/O state of the system. As shown in Fig. 3.34. It is helpful to the system monitor and fault diagnosis by observing the change of the I/O state.
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Fig. 3.34 I/O State Window
The icons in front of the port are defined as follows:
The red and solid point icon is means that there is corresponding signal to input.

The red and hollow point icon is means that there is not corresponding signal to input.
3.11 Program Edit Window
The Program Edit Window is a standard windows-style editing window, as shown in Fig. 3.35.

The user chooses Open and Load menu to open a processing file. And at the same time this file is also automatically loaded to the Program Edit Window. The difference is that the user can not change the code in the Auto Window, but he can make any change in the Program Edit Window.
The user also can directly edit the processing code in this window.
Right-click in the Program Edit Window, a shortcut menu will be popped up, as shown in Fig. 3.35. The user can choose the corresponding operation according to his need. The menu option displays gray indicate that this menu item can not be executed in the current state.
Choose Close to clear the window contents. The edited file will be saved for the later processing by the Save or Save and Load option.
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Fig. 3.35 Program Edit Window
4 Parameters Setting
Newvic has numerous machining parameters, which enable the system to perform various machining tasks. Parameters include two categories: User Operate and Factory. All the parameters only can be modified in the Stop state.
4.1 Parameters Setting Permissions
Different parameters are shown under the different permissions. Factory parameters need to input the password to enter. Double-click Factory Parameters, a dialog box appears, as shown in Fig. 4.1.
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Fig. 4.1 Password Dialog Box of Factory Parameters
4.2 Parameters Modification Method
Double-click the parameters, the Modify Parameters dialog box appears. For the value parameters, fill in the appropriate value, for other parameters, click the pull-down button and choose one option. Then click Apply, choose OK. Take the parameter Set the normal jog federate for axis X and Y for example, the Modify Parameters dialog box is as shown in Fig. 4.2.
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Fig. 4.2 Parameters Dialog Box
4.3 User Operate Parameters Description
	Name
	Set the normal jog feedrate for axis X and Y

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Rapid jog feedrate for axis X and Y

	Effective
	Immediately

	Discription
	Set the normal jog feedrate for axis X and Y.


	Name
	Set the rapid jog feedrate for axis X and Y

	Value Type
	Int

	Unit
	mm/min

	Range
	Normal jog feedrate for axis X and Y~ Max feedrate for axis X and Y

	Effective
	Immediately

	Discription
	Set the rapid jog feedrate for axis X and Y.


	Name
	Set the normal jog feedrate for axis Z

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ rapid jog feedrate for axis Z

	Effective
	Immediately

	Discription
	Set the normal jog feedrate for axis Z.


	Name
	Set the rapid jog feedrate for axis Z

	Value Type
	Int

	Unit
	mm/min

	Range
	Normal jog feedrate for axis Z~ Max feedrate for axis Z

	Effective
	Immediately

	Discription
	Set the rapid jog feedrate for axis Z.


	Name
	Idle Feedrate

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Max feedrate for axis X and Y

	Effective
	Immediately

	Discription
	Set the G00 feedrate.


	Name
	Process Feedrate

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Max feedrate for axis X and Y

	Effective
	Immediately

	Discription
	Set the cutting speed.


	Name
	Z Lifting(Idle) Feedrate

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Max feedrate for axis Z

	Effective
	Immediately

	Discription
	Set the lifting(G00) feedrate for axis Z.


	Name
	Z Lift Height

	Value Type
	Int

	Unit
	mm

	Range
	0~110

	Effective
	Immediately

	Discription
	Set Z safe height.


	Name
	Set Z Tool-dropping Feedrate

	Value Type
	Int

	Unit
	mm/min

	Range
	0~ Max feedrate for axis Z

	Effective
	Immediately

	Discription
	Set the cutting speed for axis Z.


	Name
	Enable Default Feedrate

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Yes or No

	Effective
	Immediately

	Discription
	Whether the processing feedrate declared in the file is abandoned and use the default feedrate.


4.4 Factory Parameters Description
4.4.1 Motor Parameters
	Name
	X Pulse Equivalent

	Value Type
	Bool

	Unit
	mm/pulse

	Range
	0.001~ 1

	Effective
	Restart

	Discription
	Set the displacement per pulse for axis X.


	Name
	Y Pulse Equivalent

	Value Type
	Bool

	Unit
	mm/pulse

	Range
	0.001~ 1

	Effective
	Restart

	Discription
	Set the displacement per pulse for axis Y.


	Name
	Z Pulse Equivalent

	Value Type
	Bool

	Unit
	mm/pulse

	Range
	0.001~ 1

	Effective
	Restart

	Discription
	Set the displacement per pulse for axis Z.


	Name
	X Output Direction

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Restart

	Discription
	Set the direction of axis X.


	Name
	Y Output Direction

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Restart

	Discription
	Set the direction of axis Y.


	Name
	Z Output Direction

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Restart

	Discription
	Set the direction of axis Z.


	Name
	XY Max Speed

	Value Type
	Int

	Unit
	mm/min

	Range
	1~80000

	Effective
	Immediately

	Discription
	Set the maximum speed for axis X and Y.


	Name
	Z Max Speed

	Value Type
	Int

	Unit
	mm/min

	Range
	1~10000

	Effective
	Immediately

	Discription
	Set the maximum speed for axis Z.


	Name
	G00 Acceleration

	Value Type
	Int

	Unit
	mm/s2

	Range
	1~ Max federate for axis X and Y

	Effective
	Immediately

	Discription
	Set the acceleration of G00.


	Name
	G00\G02\G03 Acceleration

	Value Type
	Int

	Unit
	mm/s2

	Range
	1~ Max federate for axis X and Y

	Effective
	Immediately

	Discription
	Set the acceleration of G00\G02\G03.


	Name
	Start Speed

	Value Type
	Int

	Unit
	mm/min

	Range
	1~2000

	Effective
	Immediately

	Discription
	Set the start speed.


	Name
	RMO speed of X and Y axis

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Max federate for axis X and Y

	Effective
	Immediately

	Discription
	RMO speed of X and Y axis.


	Name
	RMO speed of Z axis

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Max federate for axis Z

	Effective
	Immediately

	Discription
	RMO speed of Z axis.


	Name
	MPG Speed

	Value Type
	Int

	Unit
	mm/min

	Range
	1~ Max Speed

	Effective
	Immediately

	Discription
	Set MPG Speed.


4.4.2 Machine Parameters
	Name
	X axis Max Move Range

	Value Type
	Int

	Unit
	mm

	Range
	0~2100

	Effective
	Restart

	Discription
	Set the max moving rang of axis X.


	Name
	Y axis Max Move Range

	Value Type
	Int

	Unit
	mm

	Range
	0~4000

	Effective
	Restart

	Discription
	Set the max moving rang of axis Y.


	Name
	Z axis Max Move Range

	Value Type
	Int

	Unit
	mm

	Range
	0~100

	Effective
	Restart

	Discription
	Set the max moving rang of axis Z.


	Name
	X axis Min Move Range

	Value Type
	Int

	Unit
	mm

	Range
	-500~0

	Effective
	Restart

	Discription
	Set the min moving rang of axis X.


	Name
	Y axis Min Move Range

	Value Type
	Int

	Unit
	mm

	Range
	-500~0

	Effective
	Restart

	Discription
	Set the min moving rang of axis Y.


	Name
	Z axis Min Move Range

	Value Type
	Int

	Unit
	mm

	Range
	-500~0

	Effective
	Restart

	Discription
	Set the min moving rang of axis Z.


4.4.3 Spindle Parameters
	Name
	Spindle Switch Polarity

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Immediately

	Discription
	Set Spindle Switch Polarity.


	Name
	Spindle Max Speed

	Value Type
	Int

	Unit
	rpm

	Range
	1~24000

	Effective
	Immediately

	Discription
	Set the max speed for spindle running.


	Name
	Waiting Time for Spindle Start and Stop

	Value Type
	Int

	Unit
	s

	Range
	0~600

	Effective
	Immediately

	Discription
	Set the waiting time for spindle start or stop.


	Name
	Auto Stop Spindle on Stop

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Yes or No

	Effective
	Immediately

	Discription
	Whether automatically stop spindle after processing task completed or cutting stopped?


	Name
	Auto Stop Spindle on Pause

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Yes or No

	Effective
	Immediately

	Discription
	Whether automatically stop spindle on pause?


4.4.4 Compensation Parameters
	Name
	X Back Interval Compensation

	Value Type
	Float

	Unit
	mm

	Range
	0~2

	Effective
	Restart

	Discription
	Set the back interval compensation for X axis.


	Name
	Y Back Interval Compensation

	Value Type
	Float

	Unit
	mm

	Range
	0~2

	Effective
	Restart

	Discription
	Set the back interval compensation for Y axis.


	Name
	Z Back Interval Compensation

	Value Type
	Float

	Unit
	mm

	Range
	0~2

	Effective
	Restart

	Discription
	Set the back interval compensation for Z axis.


4.4.5 Factory Operate Parameters
	Name
	Polarity of Tool Setting Signal 

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Immediately

	Discription
	Set the polarity of tool setting signal.


	Name
	Thickness of Tool Calibrator

	Value Type
	Int

	Unit
	mm

	Range
	0~100

	Effective
	Immediately

	Discription
	Set the thickness of tool calibrator.


	Name
	Enable Tool Setting at Fixed Position

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Yes or No

	Effective
	Immediately

	Discription
	If enable the Tool Setting at Fixed Position, carver move to the fixed mechanical position, then set tools.


	Name
	X Position of Tool Calibrator

	Value Type
	Float

	Unit
	mm

	Range
	Min run range of X axis ~ Max run range of X axis

	Effective
	Immediately

	Discription
	Set the tool calibrator position along X direction of the machine.


	Name
	Y Position of Tool Calibrator

	Value Type
	Float

	Unit
	mm

	Range
	Min run range of Y axis ~ Max run range of Y axis

	Effective
	Immediately

	Discription
	Set the tool calibrator position along Y direction of the machine.


	Name
	Z Position of Tool Calibrator

	Value Type
	Float

	Unit
	mm

	Range
	Min run range of Z axis ~ Max run range of Z axis

	Effective
	Immediately

	Discription
	Set the tool calibrator position along Z direction of the machine.


	Name
	Enable Automatically Move to Fixed Position

	Value Type
	BOOL

	Unit
	NULL

	Range
	Choose Yes or No

	Effective
	Immediately

	Discription
	Whether the tool move to the specified position after processing task completed?


	Name
	X Fixed Position

	Value Type
	Bool

	Unit
	mm

	Range
	Min run range of X axis ~ Max run range of X axis

	Effective
	Immediately

	Discription
	Set the X axis move to the fixed position after the processing finished.


	Name
	X Fixed Position

	Value Type
	Bool

	Unit
	mm

	Range
	Min run range of Y axis ~ Max run range of Y axis

	Effective
	Immediately

	Discription
	Set the Y axis move to the fixed position after the processing finished.


	Name
	Z Fixed Position

	Value Type
	Bool

	Unit
	mm

	Range
	Min run range of Z axis ~ Max run range of Z axis

	Effective
	Immediately

	Discription
	Set the Z axis move to the fixed position after the processing finished.


	Name
	X Backward Distance after RMO

	Value Type
	Float

	Unit
	mm

	Range
	0~100

	Effective
	Immediately

	Discription
	Set the backward distance of X after return to mechanical origin.


	Name
	Y Backward Distance after RMO

	Value Type
	Float

	Unit
	mm

	Range
	0~100

	Effective
	Immediately

	Discription
	Set the backward distance of Y after return to mechanical origin.


	Name
	Z Backward Distance after RMO

	Value Type
	Float

	Unit
	mm

	Range
	0~100

	Effective
	Immediately

	Discription
	Set the backward distance of Z after return to mechanical origin.


	Name
	Min Instruction Distance

	Value Type
	Float

	Unit
	mm

	Range
	0~1

	Effective
	Immediately

	Discription
	The distance less than the min instruction distance will be ignored.


	Name
	Enable Discrete Arc

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Yes or No

	Effective
	Immediately

	Discription
	Enable discrete arc or not, this method discrete arc to line.


	Name
	Accuracy of Discrete Arc

	Value Type
	Float

	Unit
	mm

	Range
	0.001~0.1

	Effective
	Immediately

	Discription
	Accuracy of discrete arc means the level of line approach arc.


	Name
	Tool Pick\Drop Polarity

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Immediately

	Discription
	Set tool pick\drop polarity.


	Name
	Dust Hood Up\Down Polarity

	Value Type
	Bool

	Unit
	NULL

	Range
	Choose Positive or Negative

	Effective
	Immediately

	Discription
	Set dust hood up\down polarity.


5 Operation Steps
5.1 Starting the Computer
Before starting the computer, ensure that the machine is connected to the computer. Then open the machine power and the computer power. After the system boot is complete, the Newvic CNC system gets ready.

5.2 Mechanical Reset
The system will determine whether the machine has been back to the mechanical origin before entering the processing. After starting the system, the Return to Mechanical Origin dialog box will be popup first. Clicking the corresponding button, the machine returns automatically to the mechanical origin and rectifies the coordinate system.

5.3 Check I/O State
Check the input and output of each signal, check the trouble signal whether existed, to ensure the machine can process safely.
5.4 Load the File
Prior to machining, the user needs to load the file. Otherwise, certain functions related to automatic machining remain invalid.

Choose the File | Open and Load… option in menu bar, or click the right mouse button, choose Open and Load… in the popup shortcut menu, the file operation dialog box appears. Choose the drive, path and file name. Click Open and the file are loaded into the system. The user can look over the current file in the Auto window.
5.5 Manual Operation
5.5.1 Show Manual Window
Click Manual window shows the Manual the Manual window, in which the user can perform manual operations.
5.5.2 Manual Move
Choose Auto/Manual operation windows, click Manual, the Manual window will be shown. The user can perform manual move by using the buttons in the Manual window or the small number keys on the keyboard. Note: the input focus should be switched to Manual window firstly.
5.6 Determining Workpiece Origin
The origins of the X, Y and Z axes in the file are the workpiece origin. Prior to machining, this position needs to be linked with the actual position. To do this:

Move the X , Y and Z axes manually to the workpiece origin. Choose Operation |Set Workpiece Origin, or reset the current position coordinate in the coordinate window, so that machining starts from the current position.

5.7 Automatic Machining
Automatic machining means that the machine performs automatic machining to the file.
· Start Automatic Machining
Choose Operation | Start in menu bar or click the button [image: image62.png]


 in the toolbar, or press down the shortcut key F9. The machine starts automatic machining from the first file line.
· Machine Stop
To stop the file in automatic machining, choose Operation | Stop in menu bar or click the button [image: image63.png]


 in the toolbar, or press down the shortcut key F11. The machine stops after current line machining is complete, and enters the Stop status. The system can stop accurately and ordered by this way.
· Machine Pause
To pause in automatic machining, choose Operation | Pause in menu bar or click the button [image: image64.png]


 in the toolbar, or press down the shortcut key F10. The machine pauses after completing machining the current lines. To resume, choose Operation | Start in menu bar or click the button [image: image65.png]


 in the toolbar.
· Machine Breakpoint Resume
To breakpoint resume processing in the state of emergency that the processing is not completed, choose Operation | Breakpoint Resume in menu bar or click the button [image: image66.png]


 in the toolbar, or press down the shortcut key Shift+F9. The machine automatically starts to continue processing from the last stop line.
· Advanced Start Automatic Machining
Choose Operation | Advanced Start in menu bar or press down the shortcut key Ctrl+F9. The dialog box Start (advanced option) appears. Choose Specific Line, fill out the number (The line number range is the current processing file line number rang.) of the lines in the edit box. Or choose Beginning, click the OK button, the program will skip execution.
5.8 Operation Notes
As Windows is a time-sharing system, other tasks can proceed during automatic machining (e.g. editing a file). However, it should be noted:

(1) As Windows is memory-consuming, avoid opening too many windows, whose number depends on memory size.

(2) Some applications do not run stably, for example some games and VCD players. They may use up system resources without limit. For example, memory and CPU time slice may lead to system halt. Therefore, in machining, do not run those programs, to avoid accidental interrupts due to system halt.

Recommend to open only the document windows which are associated with the processing in the actual processing.[image: image67.png]
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